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Adobe Photoshop is a powerful, professional image-processing tool. It processes a variety of image 

formats. The quality of produced images is eligible for press production. Throughout this document, we 

will cover most of the basic features of this program. 

 

Start Adobe Photoshop 
To start this program, slick Start button. Choose Programs, then Adobe. This group of programs includes 

the Adobe Photoshop 5.0 program. Click this item; the program starts. 

 

New Document 
To create a new image, choose File menu then New item. A window appears with the following fields as 

the image properties:  

- Name: You can give the new image any title you wish by typing this title in this field. 

- Image Size: This field shows the expected storage space needed for this image in terms of kilobytes. 

- Width: the width of the image in terms of the measurement units stated in this field. The available 

units are pixels, inches, cm, points, picas, and columns. 

- Height: the height of the image in terms of the selected measurement units. The available units are 

pixels, inches, cm, points, picas, and columns. 

- Resolution: the number of displayed/printed pixels per inch or pixels per cm. The higher the 

resolution, the better the quality of the image. However, the higher the resolution, the bigger the 

storage size of the image and the longer time it takes to load the image online. A standard web-based 

image resolution would be 72 pixels/inch. However, the printed images should be at resolutions 200 

pixels/inch or more. 

- Mode: This field determines the color model used to display and print the image. Photoshop bases its 

color modes on established models for describing and reproducing color. This includes Bitmap, 

Grayscale, RGB color, CYMK color and Lab color. Common models include HSB (for hue, saturation, 

brightness); RGB (for red, green, blue); CMYK (for cyan, magenta, yellow, black); and Lab (for 

lightness, green-red axis, blue-yellow axis). 

- Contents: this field specifies the background color of the image. It can be white in color, uses the 

currently selected background color, or with a transparent background color. 

 

 
 

Let’s create an image with the following settings: Name: test, Width=200 pixels, height= 200 pixels, 

resolution= 72 pixels/inch, mode=RGB color, Contents=White 
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Overview on the Working Space 
The Photoshop program opens the following working space: 

- Title Bar: this blue bar includes the name of the Photoshop program augmented with the name of the 

current open document. On the right hand side of the bar there are 3 buttons for minimizing, resizing 

and closing the program. 

- Menu Bar: the main menu of commands is displayed in this bar. It includes the File, Edit, Image, 

Layer, Select, Filter, View, Window and Help menus. All the needed commands for image 

processing are accessible from these menus 

- Toolbars: a set of utilities toolbars and windows appear in the working space to facilitate the use of 

various tools and features. In case you need to access a missing toolbar, click Window menu, and then 

choose the hidden tool. 

- The Image Window: Each open image is displayed in a separate window titled with its name and can 

be minimized, resized or closed. Next to the filename, appears the zooming size of the window (its 

value is a percent of  the actual size of the image) and the color mode of this file.    

- Status bar: At the bottom of the working area appears the status bar that shows the zooming factor 

used in the current active image window – in case more than one image are open simultaneously – 

where one can change this factor by typing the desired zoom factor. The document size and an 

instantaneous help - on each action you do or command you select - follow.    

 

Toolbox 
The toolbox consists of the following useful tools:  

 

 

Rectangular marquee tool makes rectangular selections. If you place the mouse 

on top of this tool and drag it to the right, this set of tools shows up:  

 
The elliptical marquee tool makes elliptical selections. 

The single row marquee tool makes 1-pixel wide row selections. 

The single column marquee tool makes 1-pixel wide column selections. 

The crop tool trims images. 

 

The move tool moves selections, layers, and guides. You place the mouse on top of 

the selection and drag the mouse to move the selection. 

 

The lasso tool makes freehand selections. This tool has a set of sister tools: 

 
The polygon lasso tool makes freehand and straight-edged selections. 

The magnetic lasso tool draws selection borders that cling to the edges of objects. 

 

The magic wand tool selects similarly colored areas. If you double-click this tool, 

an options palette appears where you can setup the featuring factor. 

 

The airbrush tool paints soft-edged strokes. It applies gradual tones (including 

sprays of color) to an image. The edges of the stroke are more diffused than those 

created with the paintbrush tool. The pressure setting for the airbrush tool controls 

how quickly the spray of paint is applied. If you hold down the mouse button 

without dragging, you can build up color. 

 

The paintbrush tool paints brush strokes. 

 

The clone stamp tool paints with a copy of an image. 

Its sister tool is the pattern stamp tool that paints with the selection as a pattern. 

 

The history brush tool paints with the selected state or snapshot. 

 

The eraser tool erases pixels and restores parts of an image to a previously saved 

state. 

 

The pencil tool draws hard-edged freehand lines.  

Its sister tool is the line tool that draws straight lines. 
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The blur tool blurs hard edges in an image. Its sister tools are:  

The sharpen tool sharpens soft edges. 

The smudge tool smudges data in an image. 

 
The dodge tool lightens areas in an image. Its sister tools are:  

The burn tool darkens areas in an image. 

The sponge tool changes the color saturation of an area. 

 

The pen tool lets you draw smooth-edged paths. Its sister tools are: 

 
The magnetic pen tool draws paths that cling to the edges of objects. 

The freeform pen tool draws paths directly as you drag. 

The add-anchor-point tool adds anchor points to a path. 

The delete-anchor-point tool deletes anchor points from a path. 

The direct-selection tool selects and moves paths and parts of paths. 

The convert-anchor-point tool converts straight-line segments to curved 

segments, and vice versa. 

 

The type tool creates type on an image. It has a set of sister tools which are: 

 
The type mask tool creates selection borders in the shape of type. 

The vertical type tool creates vertical type on an image. 

The vertical type mask tool creates selection borders in the shape of the vertical 

type. 

 

The measure tool measures distances, locations, and angles. 

 

The linear gradient tool creates a straight-line blend between colors. Its sister 

tools are:  

The radial gradient tool creates a circular blend between colors. 

The angle gradient tool creates an angular blend between colors. 

The reflected gradient tool creates symmetric straight-line blends between colors. 

The diamond gradient tool creates diamond-shaped blends between colors. 

 

The paint bucket tool fills similarly colored areas with the foreground color. 

 

The eyedropper tool samples colors in an image. Its sister tool is the color 

sampler tool that samples up to four locations simultaneously. 

 

The hand tool moves an image within its window. 

 

The zoom tool magnifies and reduces the view of an image. 

 The current foreground color appears in the top color selection box in the toolbox, 

the background color in the lower box. The default foreground color is black, and 

the default background is white.  

 

A. Foreground color  

B. Default Colors  

C. Switch Colors  

D. Background color 

 

To reverse the foreground and background colors, click the Switch Colors icon in 

the toolbox. 

To return to the default foreground and background colors, click the Default Colors 

icon in the toolbox. 

To change the foreground (or background) color, click the top (or lower) color 

selection box in the toolbox. A palette of colors pops up. Select the desired color. 
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 Quick Mask mode lets you edit any selection as a mask without using the 

Channels palette and while viewing your image.  

To return back to the standard mode, click the standard mode button  

  To change the viewing mode of image windows, click a window control:  

A. Standard screen mode 

B. Full screen mode with menu bar 

C. Full screen mode 

 

Featuring 
Blurs edges by building a transition boundary between the selection and its surrounding pixels. This 

blurring can cause some loss of detail at the edge of the selection. 

You can define feathering for the marquee, lasso, polygon lasso, or magnetic lasso tool as you use the tool, 

or you can add feathering to an existing selection. Feathering effects become apparent when you move, cut, 

or copy the selection. 

 

Type tool 
If you wish to type text within the image, use the Type tool in the toolbox. Once you click inside the 

image, a window pops up with the following fields:  

Font: through this field, you 

can decide the font type of 

the selected text. Moreover, 

you can make the text 

regular, bold, italic, or both. 

Size: this field allows you to 

specify the font size of the 

selected text. Moreover, you 

specify the unit of 

measurement of the font size 

whether points or pixels. 

Leading: this field specifies 

the spacing between baselines 

and is measured in the units 

you specify in the Type Tool 

dialog box.  

Kerning: This field controls 

the spacing between two 

characters. You can control 

kerning manually, or you can 

turn on the auto-kern field.  

Tracking: tracking inserts 

uniform spacing between 

more than two characters in 

selected type. Use tracking to adjust the spacing of a selected word or of an entire block of text. 

Positive kerning or tracking values move characters apart; negative values move characters closer together. 

Color: this field allows you to choose the desired fill color of the selected text. 

Baseline: It controls the distance that text appears from its baseline, either raising or lowering the selected 

type to create superscripts or subscripts. 

Alignment: You can align the typed text to the left, in the center, or to the right. 

Preview: if this field is checked a view of the text with the current settings appears in the image window. 

Anti-Aliased: this option removes jagged edges from the typed text 

Rotate: When you create vertical type, you can select the Rotate option to rotate the character direction by 

90°. The Rotate option does not affect double-byte characters. 

Text Area: in this area you can type the text you that should appear in the image 

Finally, you press the OK button to apply these settings. 

Anytime you wish to change the settings of the typed text, you double-click the T in the text layer.  
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Gradient Editing 
You can apply gradient fill to any selected area. Choose the gradient tool from the toolbox. If you double-

click the gradient tool, the linear gradient window appears. This window includes the following fields:  

 

Opacity: this field sets up the level of transparency of the 

gradient fill. 

Gradient: you can select the desired type of gradient from the 

available list. Among the popular gradients, the list includes: 

Foreground to Background (starts by the current foreground 

color and gradually changes the color to reach the current 

background color), Foreground to Transparent, Transparent 

Rainbow and more. If you wish to edit any of the available 

gradients to create a customized gradient fill, press the Edit 

button. The Gradient Editor window pops up with the following fields: 

- List of gradients. 

- Adjust: to decide whether 

to adjust the colors or the 

transparency level. 

- The scale of colors allows 

you to change any of the 

colors involved in the 

composition of the 

gradient. You can add new 

colors by clicking in the 

desired position along the 

color scale. To change the 

point of transfer from one 

color to another, slide the 

diamond shape.  

- You can duplicate a 

gradient by pressing the 

Duplicate button.  

- You can remove a gradient 

from the list by pressing 

Remove button. 

- You can save gradients in separate files through the Save button.  

- You can load gradients through the Load button. 

 

Image Mode Adjustment 
One can convert the image from one mode to another through the Image menu, Mode item. There is a list 

of the available modes to choose among including Bitmap, Grayscale, RGB Color, Indexed Color, CYMK 

Color, Lab Color, and Multichannel.  As you select a new mode, you will be prompted whether or not to 

flatten the layers of the image. You have the choice to keep them or flatten them all into one layer. 

  
 

Layers Palette 
Adobe Photoshop treats any image as a set of layers on top of each other. This gives great flexibility in 

applying any effect on separate objects in separate layers. Many effects automatically paste the result in a 
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new layer. However, we can create new layers by choosing Layer menu, New item, Layer option. A 

window pops up with the fields of the layer name, percent of opacity and the mode of blending the colors in 

this layer with the colors in the layers below. 

All the created layers are listed in the Layers Palette. To display this palette, choose Window menu, Show 

Layers item. The palette consists of the following: 

- A list of the currently available layers arranged from top 

to bottom, where each one is displayed as a thumbnail 

with the layer name and indicators of the applied effects 

or type tool.  

- On the left hand side of each layer there might be an eye 

to indicate that this layer is visible in the final shape of 

the image. Otherwise, this layer is hidden or invisible. If 

you wish to hide a layer, click on the eye to hide it.  

- If there is a brush icon next to the eye, then this layer is 

the one currently being edited. The selected layer is 

highlighted with the blue color.  

- At the top of the list there is layer mode list and the 

opacity percent. They are applicable to the selected 

layer.  

- Photoshop, by default, creates a layer named 

Background as the first layer in your image. You may 

rename it, or delete it.  

- To move a layer to the bottom or at a higher level, drag 

the layer to the position you wish to place it in.  

- To delete a layer, select the layer then press Layer menu, Delete Layer item. Alternatively, you may 

drag the layer into the trash drawn at the right bottom corner of the Layers Palette.  

- If you wish to merge the currently selected layer with the one directly below it, choose Layer menu, 

Merge Down item.  

- To merge set of layers even if they are not adjacent, select them as the visible layers, then choose 

Layer menu, Merge Visible item.  

- Most of these commands can be also accessed from the arrow menu located at the right top corner of 

the Layers Palette where you can create a new layer, delete the selected layer, merge layers, edit the 

layer options, flatten the whole image, or edit the palette options.  

- To edit the effect applied on a certain layer, double-click the f icon displayed next to the layer name.  

- If you wish to edit the text typed in a certain layer, double-click the T icon displayed next to the layer 

name.  

- To link two layers together by a chain, select one of them then click on the brush area of the other 

layer; a chain will appear to indicate a link between the two layers.  

 

Color Palette 
To select a foreground color or a background color or any needed color during processing, double-click the 

current displayed color box; a color picker window will appear with the following options: 

- To the right side, you can notice a wide rectangular area with a gradient of the current color from 

which you can pick the desired degree of this color.  

- Next comes a vertical scale of colors, from which you may pick the color you want. Accordingly, the 

gradient of the picked color will appear in the wide area.  

- This scale is followed by two small rectangles colored by the current color and the new picked color 

respectively.  

- Under them there is a list of numbers indicating the settings of the newly picked color in terms of Hue 

(indicated by H), Saturation (indicated by S), Brightness (indicated by B).  

- The RGB components of the color are listed as R (stands for Red), G (stands for Green), B (stands for 

Blue). 

- Next comes the degree of luminosity (represented by L). 

- Finally the CYMK components of the color are listed as C (stands for Cyan), Y (stands for Yellow), M 

(stands for Magenta), and K (stands for Black). 

- If you wish to pick a customized color or to get a pantone color, click the Custom button.  
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Finally you press the OK button to apply the newly picked color. 

 

 
 

Brushes Palette 
The brush sizes and shapes available for painting and editing 

appear in the Brushes palette. You can add new brushes or 

delete ones you don’t need. You also can use part of an image 

to create a custom brush shape. Brush settings are retained for 

each of the painting tools (airbrush, paintbrush, eraser, pencil) 

and editing tools (history brush, rubber stamp, smudge, focus, 

toning).  

To display the Brushes Palette, choose Window menu, Show 

Brushes item. 

If you double-click the paintbrush, the Paintbrush Options 

window pops up with the following option settings: Blending Mode, Opacity, Fade (number of steps taken 

by the brush to paint a faded color), Wet Edges  (if you check it, the edges of the brush become wet in 

color). The same option settings can be applied to the airbrush tool by double-clicking it. 

 

Channels Palette  
The Channels palette lets you create and manage channels and 

monitor the effects of editing. The palette lists all channels in the 

image—a composite channel first (for RGB, CMYK, and Lab 

images), then individual color channels, spot color channels, and 

finally alpha channels. Appearing to the left of the channel name, 

a thumbnail of the channel’s contents automatically updates as 

you edit the channel. 

To display the channels palette, choose Window menu, then 

Show Channels. 

Accordingly, you can hide or show any channel separately. 

 

Select Options 
Through the select tool and the Select menu, you can apply various effects on selections.  

- From Select menu, All item, you can select the whole image or layer. 

- From Select menu, Deselect item, you can remove the selection currently visible. 
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- From Select menu, Inverse item, you can invert the selection applied on the layer or image. 

- To select a color range using sampled colors, choose Select menu, Color Range item. 

- You can modify the selection through Select menu, Modify item. 

- Transformations can be applied on the selection area using Select menu, Transform Selection item. 

- You can save selection for later use in the same image or in other images, choose Select menu, Save 

Selection item. 

- You can load selections saved from the same image or other images, choose Select menu, Load 

Selection item. 

 

Filters 
Photoshop has a rich list of filters that can be applied to any layer or selection in the image to impose 

artistic effects. You access these filters from Filter menu. 

Typed Text does not undergo these filters except if it is rendered (press Layer menu, Type item, Render 

Layer option). 

Let’s view the effect of some of the popular filters on the following image: 

 

Original 

Image 

Watercolor Plastic Wrap Rough 

Pastels 

Motion Blur Radial Blur Ink Outlines 

       

Glass Ocean 

Ripple 

Spherize Zigzag Add Noise Crystalize Mosaic 

       

Lens Flare Charcoal Conté 

Crayon 

Plaster Diffuse Emboss Extrude 

       

Trace 

Contour 

Wind Tiles Stained 

Glass 

Mosaic Tiles High Pass Paint Daubs 
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You can combine as much filters in the same layer or image as you wish. Finally, Photoshop has adopted 

the digital watermark technology to preserve the artist’s copyright of his masterpiece. This digital 

watermark is invisible but can be detected by software. The digital watermark tolerates filters and image 

processing. 

 

Resize Image 
When preparing images for print, it’s useful to specify image size in terms of the printed dimensions and 

the image resolution. These two measurements determine the total pixel count and therefore the file size of 

the image. If you wish to change the size of the image, choose Image menu, Image Size item. The Image 

Size window pops up with the following fields: 

- Pixel Dimensions: the 

on-screen width and 

height of the image. 

- Print Size: the width and 

height of the image on 

the printed-paper. 

Moreover, the resolution 

can be adjusted in this 

field. 

- Constrain Proportions: 

enforces to keep the 

proportion between 

width and height as we 

change the dimensions. 

- Resample Image: to 

enforce resampling the 

image after changing the 

image dimensions.  

 

To change only the print 

dimensions or only the 

resolution and adjust the total number of pixels in the image proportionately, make sure that Resample 

Image is selected. 

To change only the print dimensions or only the resolution and adjust the total number of pixels in the 

image proportionately, make sure that Resample Image is selected. 

 

Save As Formats 
The Photoshop document (represented by the psd file extension) is the default format in which images are 

stored. It preserves all the layers and applied effects in the image, which enables changes at any time. 

However, this format requires big storage area. To display the final image on the web, you must save a 

copy of this image in the JPG format or the GIF format. This can be done through File menu, Save A 

Copy item. Then select the jpg file format. For the GIF format, choose File menu, Export item, GIF98a 

format option. Notice that only the visible layers are included in the resulting JPG or GIF file. 

Photoshop opens a variety of image file formats – through File menu, Open item - such as TIFF files 

(taken from a scanner), GIF, JPG, BMP, EPS (for postscript), PCD (Kodak Photo CD), PDF, PCT (PICT 

file format) and more. Furthermore, Photoshop can be adjusted to receive images directly from a scanner 

through File menu, Import item. 

Inside Photoshop you can open more than one image simultaneously where you can apply copy and paste 

among these images.  


